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introduction Luci® Studio

Live two way LOW DELAY broadcast

Congratulations with your choice of Luci® Studio! Luci® Studio transforms your PC into a high quality live internet 
broadcasting receiver. Until now you had to use very expensive satellite-time or the suchlike, but now, with the 
emergence of high-speed wireless internet access and the use of Luci® Live and Luci® Studio, the cost of live 
broadcasting is practically zero.

The main features of Luci® Studio are listed below

o Receive RTP low-delay streaming, two-way, so includes sending a return channel
o Transmit RTP low-delay streams from the field, includes receiving a return channel.
o Support for multicast streaming connections, Transmit or Receive.
o Shoutcast/Icecast source.
o Easy multichannel configuration with new version 3.0. Configurations of 40 simultaneous stereo streams per computer 
are possible.
o Codecs: MP2,AAC, AAC-HE, AAC-HEV2,  G711,  G722,  ULCC, FLAC, Linear
o 24-bit ULCC audio codec, 44.1 to 384 kHz sample-rate.
o Constantly updated to the latest IP-technology and standards
o Free help desk via email

This manual consist of 5 main chapters

SYSTEM REQUIREMENTS
The kind of devices needed, software compatibility, audio cards, plugs etc. for both users, reporters, backoffice and 
program makers / technicians or web (radio) masters

QUICK INSTALLATION GUIDE
Both software installation and license or registration process is explained in detail for both users, reporters, backoffice 
and program makers

USER GUIDE / WORKFLOW
For users reporters who are using a PC equipped with Luci® Studio software

SET-UP TECHNICAL GUIDE
Luci Studio Setup allows backoffice / program makers / technicians or web (radio) masters to define the technical set-up 
and the general behaviour of the software 

HOW TO
Guides for setting up Luci Studio as a server.

system requirements

Luci® Studio software can be installed on any Windows PC with a soundcard or audio-drivers that emulate soundcards, 
like Lawo's Jade, 

Supported Windows OS:

o Windows 8
o Windows 7
o Windows Vista
o Windows XP



quick installation guide

Software installation

You've downloaded the install-program called LuciStudio..exe, just double-click on the file and it will install. If you tick
“Start Setup” you will enter the Setup program immediately which allows you to activate your PC to run the full version of
Luci Studio.
You can do this later also if you run Luci Studio Setup from your Start menu.

License activation

You will now enter the page Register

If you have purchased Luci online via www.luci.eu your Activation code
will be issued in your order confirmation e-mail. If you have purchased
Luci any other way you will also receive an e-mail with these important
numbers. Be sure to save these numbers in case you need to re-install
your Luci® Software.

Registration is the process of unlocking your software for one particular
PC. To activate, you request a unique 'key-code' that belongs to the
particular PC you use to register and want to use Luci on. 

When you buy 1 or more licenses for Luci, you receive only 1 activation
code from us that enables you to activate the purchased number of
different PC's. For each PC that you register, fill in the activation code
and press ‘Register’.  First,  a  message appears  to  confirm that  you
have an internet-connection: 

• If  you have an internet-connection and answer OK you will
receive the key-code after a few seconds.

After you have pressed 'Register' and you received the Key-code it is
automatically  filled  into  the  field  called  'Key-code'  and  a  message
appears  to  indicate  how  many  activations  you  have  left  if  you
purchased more than one.

Go to adjust the next page or choose menu “File/Save and exit” to
save and leave Setup

http://www.luci.eu/


user guide / workflow

go live

 

Start Luci Studio in your Start Menu

You will now enter the main 'Go Live' screen that you use to work with.

“Listen 5010”
Tap on this field and you can choose the profile that you want to use from
the ones you defined in Luci Studio Setup. If you have chosen a 
shoutcast or icecast station you can type in the name of the 'song-title' 
that will appear in all of your listeners internet radio player
OUT Level-meter
This is the level-meter of the outgoing signal on the internet. Including a 
peak-hold
IN Level-meter
This is the level-meter of the incoming return signal. Including a peak-
hold and a little light with 3 states: off for no incoming signal, green for 
incoming signal without errors, red when a receiving error occurred
No file loaded
If you load a file for playing while broadcasting, its name will appear 
here. Now it's only telling you that you have no file loaded yet
default2-00
The name that will be used when you make a recording
00m:00s
The length of the current recording in minutes:seconds
Furthermore you see 2 big buttons and 2 smaller buttons:
The big buttons are the ‘Play-button’ (shown in the OFF-state here) for 
playing a pre-recorded project or file and a ‘MIC-button’ to activate the 
Microphone (internal or external, shown in the OFF-state here).
The smaller buttons are a 'Record-button' (shown in the OFF-state here 
also) to start recording and an ‘Antenna-button’ (shown in the OFF-state 
here) to connect to your internet radio-server or start listening for 
incoming connections.

   

 

connect to your server 

Press the 'Antenna-button'. Luci Studio will try to contact your server you 
have setup with Luci Studio Setup or starts listening for incoming 
streams when the profile is setup for listening for incoming connections 
ie act as a server. While doing so, half of this button will flash until a 
connection is made, then the whole button will be lit.

If no connection can be made, flashing will stop after a while and the 
button will not be lit. Try again and / or contact your program producer 
back at the radio station.

   



 

All set ?

Press the MIC-button to go live

You are now sending your Mic-signal to the server. The server will send a
return audio signal back which causes the Input-light to become green 
indicating you have a valid return signal. You can now communicate with 
the studio.

 

If you're using the PC-version you can not move or close this window 
while you are connected. You must first stop the MIC- and Connect 
-button. This is a security protection against accidental mouse-clicks that 
might stop your transmission.

   

 

Choose a different station 

If you have predefined several station profiles in Luci Studio setup, you 
can choose the menu-item Tools → Station. Alternatively, you can also 
click on the name of the station ( “listen 5010” in the image above).

 

A small window appears with all stations in a list. Choose one and press 
OK to switch over to that station or just double click on one

You can also sort the stations according to the alphabet or the last time 
you were connected. 

 

user guide / workflow

save live

 Recording while broadcasting live

You have the ability to save the live audio that you transmit by 
recording the item. This is a precaution in case you loose your 
internet-connection but are still sending important news and you do 
not want your recordings to get lost. It is best to define a new project 
before starting to record.

Choose menu File → New project for recording

Luci will then ask you for a name that will be used for the recordings.

For this example the name ‘Newp’ is chosen.



   

 

Now Go Live by tapping the MIC-button

Then press the Record-button

The time-indicator will start to run and the name besides the Record-
button will be the file you are recording. If you press the Record-button
again, recording stops. If you then press the Record-button again, 
recording continues in the same file as before. Only if you deactivate 
the MIC-button, this recording will be closed and the filename 
increments to Newp01 to indicate the new filename you will record the
next time.
You can also record without broadcasting Live: Press Record and 
then Mic or vice-versa. 

 



user guide / workflow

insert pre-recorded material while live reporting from the field.

 

You can play pre-recorded material while you are on the air

For this you must first load a single uncompressed wave-file to play.
The file  must  also  contain  the  same number  of  channels  as  the
stream you are transmitting. So, stereo file for stereo and mono file
for mono. Supported sample rates are 44.1 and 48 Khz. Supported
bit depth is 16 or 24-bit.

To load a single file choose menu File → Open file for playing

After you have chosen the file called ‘My Interview00’ for instance,
the name will appear above the ‘Play-button’ and the total recorded
time of this file will appear at the bottom left of this button.

   

 

Add pre-recorded files while broadcasting live

Go live by pressing the MIC-button

After a short live introduction you can now add the pre-recorded file 
by pressing the ‘Play-button’. You will now see that the MIC is 
switched off automatically (for the case where you have set the fade 
to be Auto mic mute in Live2Setup) until the playing of the pre-
recorded file is finished. Then it will switch on again automatically. 

Watch the time-indicator at the bottom left of this button. It will start 
to count down and the ‘Play-button’ will gradually ‘run empty’ (see 
next screenshot). 

If you want to interrupt the transmission of the pre-recorded file: 
press the ‘Play-button’ again, or press the ‘MIC-button’ in order to 
immediately switch over to live broadcasting yourself.

You can of course also transmit only pre-recorded files without 
actually broadcasting live yourself. 

 



 

playing

Watch the time indicator at the bottom left of the Play-button. It is 
counting down and the Play-button will gradually 'run empty'. 6 
seconds left and then this file has been transmitted completely.

 

 



user guide / workflow

keyboard shortcuts
The following keyboard shortcuts are available on the PC:

S = Choose Station

C = Connect

Space-bar= Mic

P = Play

L = Load file or project for playing

Switch on the “button-guard” when you are afraid of accidental keyboard-presses, see Setup/Options page

 

 



set up technical guide

Register

 

If  you  have  purchased  Luci  online  via  www.luci.eu your
Activation code will be issued in your order confirmation e-
mail. If you have purchased Luci any other way you will also
receive an e-mail with these important numbers. Be sure to
save  these  numbers  in  case  you  need  to  re-install  your
Luci® Software.

Registration is the process of  unlocking your software for
one particular PC. To activate, you request a unique 'key-
code' that belongs to the particular PC you use to register
and want to use Luci on. 

When you buy 1 or more licenses for Luci, you receive only
1 activation code from us that enables you to activate the
purchased number of different PC's. For each PC that you
register, fill in the activation code and press ‘Register’. First,
a message appears to confirm that you have an internet-
connection: 

• If you have an internet-connection and answer OK
you will receive the key-code after a few seconds.

After you have pressed 'Register' and you received the Key-
code it is automatically filled into the field called 'Key-code'
and a message appears to indicate how many activations
you have left if you purchased more than one.

Go to adjust the next page or choose menu “File/Save 
and exit” to save and leave Setup

 

 

http://www.luci.eu/


set up technical guide
New project

 

Select folder+name
Enables you to select the default folder and name of a new project 
that is used for recording.
Default Output format
This is where you set the default format when you define a new 
Station.
Stereo
Tick this to broadcast in Stereo. 
AAC-HE
Choose the codec you want to use.
Bitrate (Kbps)
The bitrate to use, possible values:
MP2: 48 to  256 kbps.
AAC mono: 32 to 160 kbps
AAC stereo: 64 to 256 kbps
AAC-HE mono: 16 to 64 kbps
AAC-HE stereo: 16 to 128 kbps
AAC-HEv2 stereo: 16 to 56 kbps.
AAC-HE oversampled SBR stereo: 96 to 256 kbps.
Record format
If the user records with the main program, you have 2 options for the 
format of the recording:
Output format – the recording will be done using the same format as 
set above. This feature is very useful if you want to locally backup 
everything that is transmitted without the need of playing this live 
again.
Wave – the recording will be done in uncompressed wave-format.
This is useful if you want to use the recording in Luci Studio again.
Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

 

 



set up technical guide
Stations1

 
Profile
You can store up to 1000 server profiles. In Luci Studio you then 
have the ability to choose between them. You will see a drop-down 
list with all currently defined profiles and a profile called ´New´ that 
enables you to add a new profile and ´Delete´ that will delete the 
currently selected profile. If you have only 1 profile you can not 
delete that.
Each profile can use a different output format. If you choose Output 
format “New project” this profile will use the general output format as 
set before in the 'New project” page. Look at the 'New project' setup 
for explanation about the different available formats.
Server
The name of your radio server and port-number. In the common 
form: ´servername:portnr´ for instance ´radio789.com:5004´. If you 
do not fill in the :portnr Luci will use the default port, which is 5004. If 
you use Luci Studio only as a receiver i.e. server do not fill in the ip-
address. But fill in :5004 for instance(including the colon). It will still 
send a stream back when it receives a valid stream.
Besides using a URL you can also fill in an ip-address. 
For ipv4 for instance: 192.168.1.100
For ipv6 you should put the address between square brackets like 
this: [2001:980:4937:1:1483:291:1351:a206] . You can of course also
use a URL with ipv6.  
User
Fill in the user-name you use to login at your server. For the RTP 
protocol this is not used.
Password
Fill in the password belonging to your user name. This password can
also be used in a simple RTP authentication.

Protocol
Shoutcast, Icecast, Multicast Src , Multicast Rcv, RTP, UDP or 
N/ACIP
Luci Studio's use of the UDP and RTP protocol is explained 
extensively in the server installation guide. We advice to use RTP on 
port 5010 .
N/ACIP
For this protocol you should use the following conventions for the 
different fields.
Field Server: “user@URL:port”
So, “user” is the one who you want to call. If you want to call without 
specifying a user name, just enter here something like “dummy”.
Some examples:

• “502@204.24.156.12:5062″ means you want to call user 
502 at the sip server's ip-address 204.24.156.12 on sip-port
5062

• “echo@iptel.org” means you call user echo at iptel.org on 
sip-port 5060 (5060 is the default when no port has been 
specified). Btw, this address actually works, but only with 
G711 codecs.

Fields User and Password are YOUR credentials when you want to 
logon to a sip-server. When you do NOT specify a user, Luci will not 
try to REGISTER to the sip-server.

Multicast Src
Field Server: 
IP-address:port , example: 224.10.1.1:7006

Multicast Rcv



Field Server: 
• IP-address:port , example: 224.10.1.1:7006 or
• sourceIP,multicastIP:port for Source Specific Multicast , 

example: 192.168.1.10,224.10.10.10:7001
With Multicast Rcv protocol you can also add a failover Server where
Luci Studio can connect to when the original stream stops. Accroding
to conditions defined in the Options page in Setup. For an 
explanation of the settings, see the Options page.

Extra audio delay

Here you can set an extra audio delay of  0 to 10.000 ms ( 10 
seconds) for different protocols:
Multicast Src: extra delay before transmitting.
Multicast Rcv: extra delay at local audio output.
All other protocols: extra delay before transmitting.

Use global RTP/UDP settings
You can have different RTP/UDP settings per station or you can use 
the global RTP/UDP settings set with the RTP/UDP page. For an 
explanation of the settings, see the RTP/UDP page.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

EXPLANATORY FIELDS AND BUTTONS FOR THE 
SHOUTCAST AND ICECAST PROTOCOL 

If you have chosen the shoutcast or icecast protocol you will see 
another feature list, as can be seen on the left. Some features are 
removed, others are added:
Mount
The mount-name, for Icecast servers.
Stream name
The name of your radio-station.
Test
You can test your server-settings with this button. Luci live two will try
to contact your server.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup



set up technical guide
Import station list

To save you the burden of manually inputting a long list of
servers you can use also use a spreadsheet to define your
stations and import this spreadsheet in Setup.
File-format  is  csv  (comma  seperated  values),  this  is  a
common format  for  simple  lists  which  can  be  made  and
edited with any spreadsheet or even text-editor. 
Just choose the menu-item “File/Import Station List” Below
you see an example list. The first line of the csv-file must be
the same as the first line of this example.
All entries are not case-sensitive. Each line beneath the first
line represents a different server-profile.
And example and reference document can be downloaded
here: http://www.luci.eu/?page_id=191

 

 

http://www.luci.eu/?page_id=191


set up technical guide
Stations2

 

The user can also update the station list with a station-list 
you can store on any webserver. Format (CSV) is the same 
as import station-list. 

External station file URL
Only when a URL is entered the user will see a button called 
“Update” in the “Choose a Station” window, see image below. The 
imported stations are appended to the local list from Luci Studio 
Setup and cached locally. The list is always updated manually, no 
automatic update takes place.

And example and reference document can be downloaded
here: http://www.luci.eu/?page_id=191

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

http://www.luci.eu/?page_id=191


set up technical guide
RTP / UDP

 

Output
64kbps upload max.
If you have an upload connection of only 64 kbps you must tick this 
box. Luci will then only allow you to choose bitrates of 32,48 and 56 
kbps. And because extra bytes have to be sent for the internet 
protocol, Luci will also optimize the data that is sent so that it really 
fits 64kbps with the shortest possible delay.
Send password
Only valid for RTP protocol. Luci will encrypt the password and send 
it with the RTP-protocol in the so-called SSRC field. At the receiver, 
this can then be used to authenticate a stream. 
This is not standardized within the RTP protocol but is a simple way 
to add extra security and authentication. At this moment this only 
works with Luci at the receiving end.
QOS
Quality Of Service uses the DiffServ conventions to define the type of
stream that Luci sends in ipv4 or ipv6 packets. You can set the type 
“Voice”  for maximum priority and “Audio/Video” for slightly less 
priority as Voice.
Flow control
When QOS is set you can enable “Flow control” which will let the 
Windows OS manage the stream better as the streaming bitrate will 
be known to the OS.

Input
Extra jitter-buffer
Fill in the number of milliseconds you want to use for the buffer to 
compensate for network-jitter.
Filter on password
Only valid for RTP protocol. If you receive a stream from another Luci
you can refuse any stream that hasn't got the same password set as 
you.

Compatibility
Choose the compatibility mode when you connect to an IP-codec 
that needs special signalling to work with Luci:
Mayah
Compatibility mode where you can choose the format and bitrate of 
the return-signal and the return stream will be shut down when you 
disconnect Luci.
Prodys
Improves AAC-HE compatibility with Prodys codecs.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

 

 



set up technical guide
Play

 

Here you can set how the Mic-input is muted when you play pre 
recorded files. You can choose to mute instantly, or fade in and out, 
or even gently cross-fade.

Fade type
In this drop-down menu you will find 5 options:

1. Auto Mic mute
The Mic is muted instantly when you press the play button 
and is automatically switched on when the playing stops.

2. Manual Mic mute
When you start to play the file the Mic is only muted when 
you manually switch it off. You must also manually switch it 
on again near the end of the playing file. 

3. Auto Mic fade
Like 1. but now the Mic is faded out with the fade-time you 
set in the below field 'Mic fade out time'. The same goes for 
the fade-in near the end of the playing file.

4. Manual Mic fade
Like 3. but now you have to manually start the fade-out and 
fade-in. 

5. Auto Xfade
A gentle cross-fade is made between the playing file and 
the Mic. Using the fade-out and -in times set below. Fade-
out time is for when you start playing the file. Fade-in time is
for near the end of the playing file.

Mic fade out time
Type in the nu,ber of milliseconds you want the fade-out to last.

Mic fade in time
Type in the nu,ber of milliseconds you want the fade-in to last.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup.

 

 



set up technical guide
InputEQ

 

The 'Input EQ' enables you to perform some equalizing during 
recording. This feature will be removed in a future version, as this 
was meant for use on older Pocket PC's. Luci Studio is only used 
with Windows PC's with good soundcards nowadays.

Allow profile selection in Luci
Switch this on to allow the user to choose an Input EQ type you 
predefined here. This allows them to use different EQ settings for 
internal Microphone, external Microphone of type A, external 
Microphone of type B , etc.
Profile
Choose a profile or give a profile a name. You can define 5 profiles 
maximum.
Overall gain
Set the overall gain of this EQ setting.
High – Mid - Low
There are 3 parametric bands available: low, mid and high. You can 
individually switch On or Off each band.
EQ Enable
Here you can switch On or Off the EQ all together. 

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup

 

 



set up technical guide
I / O 

 

The I/O (Input / Output) tab enables you to setup the audio input and
output.
Allow user to change Audio I/O
Enable this to be able to choose the Input and output in the main 
Luci Studio program.
Audio Input
Choose the input you want to use from the drop-down menu. 
Audio Output
Choose the output you want to use from the drop-down menu. 
Force mono
Force the output to be mono always even when a stereo stream 
arrives.
Audio buffer length
Here you can set the buffer-length of the Audio I/O. Usually the 
default of 50 ms is a good setting, but for a low performance 
soundcard on Windows Vista or Windows 7 this should be set to 100
to 200 ms.

Sample-rate:
Choose the sample-rate for the input and output you want to use. 
Set the sample-rate on the Audio I/O card.

ASIO
If you have a soundcard with ASIO driver you can choose it here.

Go to adjust the next page or choose menu “File/Save and exit” 
to save and leave Setup



set up technical guide
Options

 The Options tab enables you to switch On the display of several 
features of the 'Go Live' tool in Luci live two. In addition you can also 
switch on and off some options concerning the behaviour of Luci 
Studio.

EXPLANATORY FIELDS AND BUTTONS 

View
Switch on and off some features in the 'Go Live' tool.
Max. Recording time
Show the maximum recording time available
Battery-state
Show the battery-state
Digital gain knob
Show a gain knob in order to adjust the gain of the input.
Output Volume knob
Show an output volume knob in order to adjust the output level.
Server View
Show the main Go Live tool in a minimal size. This is useful if you 
have many different instances running on your PC.
Show Status
Enable the display of a status Window in the main program. Press 
the I button to show it when you are in Server View.
Menu Bar
Show the standard Windows menu bar or a minimized arrow you can
click to show the menu-items.

Allow multiple instances
If you purchased the possibility to use multiple servers on the same 
PC, you can enable this. You can also see how many you have 
purchased.
Go Live
Check this and Luci Studio will go on air immediately after starting up

Try to minimize I/O cross-talk
If you experience cross-talk of the return-channel into the signal that 
is broadcast, tick this. Luci will then try to reduce this. This only 
works when an external microphone is connected.

Button-guard
If you enable this, Luci Studio will ask you for confirmation when you 
want to stop the live-stream.

Time out as a server
If you have Luci configured as a server (listen to incoming streams) 
you use this setting to set the time Luci will keep sending the return 
stream before it stops and starts listening to incoming streams again.

Logging Level
Here you can set Luci Studio to log what it's doing, for debugging 
purposes. If you experience any problems, set this to Normal and 
Luci will write a file called lucilog.txt in the folder 

c://user/you/appdata/lucilive2/ or in the folder where you 

started Luci Studio. Send this file to windows@luci.eu and also 
include live2ini.sup from the same folder so we can see what your 
settings are.

Net Interface
Choose the network card you want to use

Error signalling
This group of options is for the Multicast Rcv protocol, it enables you 
to define the failover conditions:

Server View

mailto:support@luci.eu
file:///c://user/you/appdata/lucilive2/


• No audio trigger level: if incoming audio-level from the 
network is below the specified threshold it is considered as 
No audio.

• No audio trigger period: the period that the No audio level 
must be detected before an error conditions is signalled.

• Restored audio trigger period: the period that the audio 
must be present before the error condition is signalled as 
solved.

• Repeat notifications fast period: after an error condition Luci
will send SNMP traps at a fast rate, you set the rate here.

• Number of fast notifications: the number of fast notifications 
to send be fore a slow rate is used.

• Repeat notifications slow period: you set the slow 
notification period here.

Choose menu “File/Save and exit” to save and leave Setup.

 



how to 

setup and connect Luci Live with Luci Studio



Here is how you setup and use Luci in several
network situations.

 Both on the internal network.

Suppose you have Luci Live running on a computer with ip-address 
192.168.1.102 and a computer with Luci Studio on ip-address 
192.168.1.100

Set the one that's at 192.168.1.102 , Luci Live, to connect to the 
other: 192.168.1.100 at port 5010.

If your network uses computer-names you can also use these 
names instead of the ip-address. So if for instance 192.168.1.100 is 
a computer called "intcomp1" you can also fill in " intcomp1:5010 " 

If your network uses a DHCP-server, using the computer-names is 
also the best way to connect.

Set the one that's at 192.168.1.100 , Luci Studio, to listen for 
incoming streams at port 5010.

All you have to do is to not fill in the name or address of the server 
(ie. no server) like on the left.

Notice there is no ip-address or URL filled in. Please don't forget the 
colon before the port number. 
This will cause Luci Studio to listen to incoming streams and not 
send any stream if there is no stream coming in. If it receives a valid 
stream, it will start sending back to the Ip-address and port where 
the stream is coming from. This technique is commonly known as 
"Symmetric RTP" .

Start Luci Studio in server view mode, click on the antenna.



Then start Luci Live, click the MIC, check levels and then click the 
Antenna.

One side on internal network, the other on the 
public internet 

 This is the common case when you have reporters in the field with 
Luci Live on their Phone or laptop and they want to transmit live to 
the studio for direct transmission on-air. 

The studio will have it's own static ip-address and may even have 
webservers running in house. Luce Live will then have to be 
configured for use as a live contributor on the Phone or laptop and 
Luci Studio as a server in the studio. 

First thing you have to do is to make sure that the port for UDP 
(normally 5010) is forwarded to the computer where your copy of 
Luci Studio is running on (call it a Live-server). This is the same as 
what you do when you forward traffic for your webserver on port 80 
to your webserver.

On the Live-server 

All you have to do is to not fill in the name or address of the server 
(ie. no server) like on the left. Just like in the example above where 
both computers are running on the same network.

Notice there is no ip-address or URL filled in. Please don't forget the 
colon before the port number. 
This will cause Luci Studio to listen to incoming streams and not 
send any stream if there is no stream coming in. If it receives a valid 
stream, it will start sending back to the Ip-address and port where 
the stream is coming from. This technique is commonly known as 
"Symmetric RTP" .

You can use this in combination with the Start-up option "Go Live' in 
the Options-page of setup.This will cause Luci Studio to immediately
start listening when you start the program. It is also wise to put a 
shortcut to Luci Studio in the startup-folder of your PC, so it starts 
automatically each time the computer restarts. 



On Luci Live in the field. 

You have to fill in the public ip-address (take it from your router) or 
URL of the studio. Like on the left. 

Start Luci Studio in server view mode, click on the antenna.

Then start Luci Live, click the MIC, check levels and then click the 
Antenna.



how to 
setup Luci Studio as a server

Any Luci Studio can act as a mono or stereo server for high
quality audio over IP.

To make Luci Studio act as a server, do not fill in any ip-
address in the "server"-field at the "Server"-page in Luci 
Studio Setup. Like you can see on the left. Don't forget to 
add the colon ( : ) before the port you want to use. This will 
cause Luci Studio to listen to incoming streams and not 
send any stream if there is no stream coming in. If it 
receives a valid stream, it will start sending back to the Ip-
address and port where the stream is coming from. This 
technique is commonly known as "Symmetric RTP" .

You can use this in combination with the Start-up option 
"Go Live' in the Options-page of setup.This will cause Luci 
Studio to immediately start listening when you start the 
program. It is also wise to put a shortcut to Luci Studio in 
the startup-folder of your PC, so it starts automatically each
time the computer restarts. 

To be able to connect to the server from outside your own 
network, you must make sure that the port for RTP 
(normally 5010) is forwarded to the computer where your 
copy of Luci Studio is running on (call it a Live-server). This
is exactly the same as what you do when you forward traffic
for your webserver on port 80 to your webserver.



how to 
setup Luci Studio as a multi-channel server
 It is possible to start Luci Studio several times simultaneously on the same PC with different settings. Then there 
are multiple so-called "instances" of Luci Studio running which enables you to receive multiple streams 
simultaneously. To accomplish this do the following.

1.Download Luci Studio and install in a folder 

called C:\LuciMC for instance.

2.Start Luci Studio Setup and create a profile like 
on the left , using port nr 5010 

3. Set an Audio Input and Output..

file:///C:/LuciMC
http://www.technicadelarte.com/download/ls/latest/lucistudio.exe


4. Also Enable “Allow multiple instances “ in the 
Options page. You see there are 4 licensed here, 
but for the purpose of this manual we use only 2. 
Each instance can handle a stereo input stream 
and stereo output stream.

5. Choose menu item File/Save as... and save 
under filename C:\LuciMC\Channel12.sup for 
instance.

6. Change the portnr and Audio I/O and save 
under different filename 
C:\LuciMC\Channel34.sup for instance.

.

7.Then Quit Setup and drag each .sup to Luci 
Studio or double-click on each .sup file

8. Arrange the windows and press the I button to 
show the status window.

You can also make a start.bat file with this content 
to start all 2 files with one click:

start "Live1" "Luci Studio".exe Channel12sup

start "Live2" "Luci Studio".exe Channel34.sup

9. To edit each setup file again, drag it to Luci 
Studio Set up , or right-click on the .sup file and 
choose “Edit” from the Windows Shell menu.

You now have the ability to receive multiple simultaneous mono or stereo streams that are output at different audio-
outputs. Each stream also has separate return-channels. 
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